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1. Introduction 

 
On 2 October 2014, the World Anti-Doping Agency (WADA) published the Technical 

Document for Sport Specific Analysis (TDSSA), which is intended to ensure that Prohibited 

Substances within the scope of the TDSSA are subject to an appropriate and consistent level 

of analysis by all Anti-Doping Organizations (ADOs) that conduct testing in the relevant 

sports and disciplines. Compliance with the TDSSA is mandatory under article 5.4.1 of the 

World Anti-Doping Code (Code); and, since 1 January 2016 WADA has been monitoring 

implementation of the TDSSA closely. 

 

On 1 June 2016, following a decision by WADA’s Executive Committee, it became 

mandatory for ADOs to enter all Doping Control Forms (DCFs) into the Anti-Doping 

Administration and Management System (ADAMS) no later than 15 business days after 

sample collection.  

 

As both TDSSA implementation and entry of DCFs into ADAMS are mandatory, WADA 

monitors them closely from a Code compliance perspective, including via the Code 

Compliance Questionnaire (CCQ). Failure to comply with these requirements can result in a 

declaration of non-compliance. 

 

WADA developed this new Reporting Guide to Monitor Testing in order to assist ADOs with 

these compliance requirements. The Guide provides step by step instructions to: 

 

 generate relevant reports in ADAMS; 

 cross check the data and; 

 take the necessary action to eliminate any data entry errors  

 

so that ADOs can monitor their compliance with the TDSSA and DCF entry based on 

accurate testing data.  

 

There are various ways to determine the number of tests and analyses from the ADAMS 

reports. This Guide illustrates only a basic way to perform the exercise. For instance, ADOs 

may use pivot tables, macros and other formulas such as vlookup in Excel to extract the 

relevant figures based on the principles outlined in this Guide.  

 

Internet Explorer 11 and Microsoft Excel 2016 were used to create the screenshots and the 

instructions in this Guide. The procedures may be slightly different on other web browsers 

and different versions of Microsoft Excel. 

 

All ADAMS templates recommended in this Guide are created in the current ADAMS system 

and require some manual handling of data to identify the missing or wrong information, if 

any, and to extract the relevant figures for compliance monitoring. Enhanced reporting 

functions will also be part of the New Generation ADAMS, which is in development, to 

simplify the monitoring process in the near future.   

 
  

https://www.wada-ama.org/en/resources/the-code/tdssa-technical-document-for-sport-specific-analysis
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Overview of the monitoring process: 

 

           

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Generate a Laboratory Result 

Report (LRR) in ADAMS by using 

the WADA template 

  Cross-check the data in LRR and SCR 
to identify data entry errors 

Initiate corrective actions to eliminate 

the mistakes in the reports 

Generate an updated LRR to 

monitor DCF entry 

Generate a Sample Collection Report 

(SCR) in ADAMS by using the WADA 
template 

Generate an updated SCR to monitor 
compliance with the TDSSA 
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2. Generate a lab result report (LRR) in ADAMS 
 

The LRR retrieves information from the sample analysis results that are submitted by 

Laboratories in ADAMS. 

 

2.1 Choose the Lab Result Report in the Reports module on the ADAMS main page. 

 

 

 
2.2 Open the existing template created by WADA. 

 

a) Click open at the top right corner of the LRR page. 

b) In the pop-up1 Open report window: 

 

 Select WADA-AMA in the Organization field;  

 Choose LRR DCF Entry Monitor in the Report group field;  

 The name of the template LRR DCF Entry Monitor will appear in the Report 

name field. 

 

c) Click open to open the template. 

 

2.3 Click select to choose your organization in the Testing Authority field and then 

click save. 

 

 

                                           
1  ADAMS requires pop-ups to operate properly. Please ensure that your browser allows pop-ups 
coming from https://adams.wada-ama.org/adams/ 
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2.4 Specify the Collection Date range to define the scope of data to be included in 

the report. This can be done by either typing a date in the from/to fields or 

selecting from the pop-up calendar. 

 

 
 

2.5 Click view report at the top or bottom of the LRR page to launch the report and 

start retrieving data. 

 

 
 

2.6 A Report has been launched window will pop up. Click on go to My Reports to 

proceed to My Reports page. 

 

 
 

2.7 Open and view the completed LRR. 

 

a) Use the Refresh button to refresh My Reports page if the report is not yet 

completed after the page is open. 

b) Click on the Completed status icon and the report will open as a CSV file. 



October 2017 V. 1.0 

Page 7 of 21 
 

 

 
 

c) If the data are clustered in the first column of each row in the CSV file, you will 

need to change the List separator setting in your computer and then open the 

CSV file again. Go to Control Panel-Region-Additional settings. Set List separator 

value to comma “,” as shown in the screenshot below. Open the csv file again 

and it will look as a properly formatted spreadsheet. 

 

 
 

2.8 Convert the CSV file to an Excel spreadsheet: 

 

a) When the CSV file is opened, click the File tab at the top left corner of the Excel 

window and select Save As. 

b) Click the drop-down menu to the right of Save as type and choose the Excel 

Workbook (*.xlsx) option at the top of the list.  

c) Type a name for the new file in the File name field, then click on Save.  

d) It is suggested to add the date when the report is generated in the name of the 

file to track data extracted from ADAMS on different days.  
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3. Generate a sample collection report (SCR) in ADAMS 
 

3.1 Back in ADAMS, choose the Sample Collection Report in the Reports module 

on the ADAMS main page. 

 

 
 

3.2 Open the existing template created by WADA: 
 

a) Click open at the top right corner of the SCR page. 

b) In the pop-up Open report window: 

 

 Select WADA-AMA in the Organization field; 

 Choose SCR ADO Statistics Report in the Report group field;  

 The name of the template SCR ADO Statistics Report will appear in the 

Report name field; 

 Click open to open the template. 

 

3.3 Click select to choose your organization in the Testing Authority field and then 

click save. 

 

3.4 Specify the Collection Date range to define the scope of data to be included in 

the report. This can be done by either typing a date in the from/to fields or 

selecting from the pop-up calendar. 
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3.5 Click view report at the top or bottom of the SCR page to launch the report and 

start retrieving data. 

 

3.6 Open and view the completed SCR. 

 

a) Use the Refresh button to refresh My Reports page if the report is not yet 

completed after the page is opened. 

b) Clicking on the Completed status icon will open the report as a CSV file. 

 

3.7 Open the report as a CSV file and convert it to an Excel spreadsheet as explained 

in section 2.8. 

 

4. Identify and correct mistakes in ADAMS reports  
 

ADOs are recommended to generate a LRR and a SCR to verify the accuracy of the analysis 

data related to their organization on a regular basis (i.e. monthly) so that corrective actions 

are initiated in a timely fashion to address the data entry errors in ADAMS, if any, before 

further compliance monitoring can be conducted. Such checking and correcting exercise is 

also important to ensure that ADOs’ testing data are accurately reflected in the global Anti-

Doping Testing Figures Reports.  

 

The LRR generated by following the instructions in Section 2 of this Guide contains the 

results of all urine and blood samples reported by the laboratories in ADAMS with your 

organization as the Testing Authority (TA). Athlete Biological Passport (ABP) blood sample 

results are not included in this LRR and those results can be extracted separately from a 

biological result report in ADAMS if needed.    

 

The SCR generated by following the instructions in Section 3 of this Guide contains all urine 

and blood samples for which your organization has created the Doping Control Forms 

(DCFs) in ADAMS and is recorded as the TA. 

 

ADOs should verify the sample codes in the two reports against one another.  

 

For a small number of samples, an easy way could be sorting the sample codes from 

smallest to largest in both reports, copy them to two columns next to each other in one 

Excel worksheet and then compare the codes in the same row. See the illustration below. 

 

https://www.wada-ama.org/en/resources/laboratories/anti-doping-testing-figures
https://www.wada-ama.org/en/resources/laboratories/anti-doping-testing-figures
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For a large number of samples, it is recommended to use the “vlookup” formula in Excel. 

See the following video which demonstrates how to use this formula to verify if the LRR 

samples are in the SCR: 

 

https://www.wada-ama.org/sites/default/files/video_on_vlookup.mp4 

 

 

 
 

The four arguments in the vlookup fomula are: 

 

1. Lookup_value: the cell to the left of the formula, containing the sample codes in LRR; 

2. Table_array: the sample codes column in the SCR; 

3. Col_index_num: 1; 

4. [range_lookup]:FALSE (exact match) 

 

https://www.wada-ama.org/sites/default/files/video_on_vlookup.mp4
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4.1 Check the sample codes in the LRR against the SCR.   

 

Check whether all the sample codes in the LRR are included in the SCR. If some 

sample codes included in the LRR are missing from the SCR, the DCFs may not 

have been created yet in ADAMS for very recent tests within 15 business days 

(the results are reported by the laboratory before the DCFs are entered by the 

ADO), or there could be a mistake in the TA field in the laboratory result created 

by the laboratory.  

 

Corrective Actions for the ADOs:  

 

 Refer to your own files to verify if you had a testing mission at the date 

corresponding to the collection dates of the missing sample codes. If so, verify your 

documentation to ensure that all the DCFs were created in ADAMS. Refer to Section 

5 of this Guide for more information. 

 If the sample that is missing in the SCR is a double blind sample for the laboratory 

quality control purpose, you should remove this sample from the LRR.  

 If you have no mission corresponding to the collection dates of the missing codes, 

the samples probably do not belong to your organization. Contact the laboratory to 

ask them to verify the TA on the original copy of the corresponding DCFs or the chain 

of custody and to modify the TA in the laboratory result in ADAMS accordingly.  

 In some cases, the Sample Collection Authority (if different from the Testing 

Authority) may need to be contacted to provide clarification on the information 

included on the DCF original copy. 

 

4.2 Check the sample codes in the SCR against the LRR.   

 

Check whether all urine and blood sample codes in the SCR are also included in 

the LRR. If some sample codes included in the SCR are missing from the LRR, the 

laboratory may not have reported the results yet in ADAMS (normal pending 

results) or there could be a mistake in the TA field in the laboratory result.  The 

samples that are not found in the LRR could have been reported under another 

ADO by the Laboratory.   

 

Corrective Actions for the ADOs:  

 

 Refer to your mission documentation to ensure the sample codes from the SCR are 

correct. Refer to Section 5 of this Guide for more information. If it has been more 

than 10 working days since the sample were received by the laboratory (Article 

5.2.6.5 and 6.2.6.5 of the International Standards for Laboratories), contact the 

laboratory to follow up on the pending results.  

 If the sample missing in the LRR is a sample that was not analyzed by the 

laboratory upon agreement with the ADO, contact the laboratory and ask them to 

submit the result as “not analyzed” in ADAMS.  

 If all the information from the SCR is correct, contact the laboratory to ask them to 

verify the TA on the original copy of the DCF and to modify the TA in the laboratory 

result in ADAMS accordingly (if applicable). 

 

4.3 Reject the match between a DCF and a laboratory result.   

 

Once a DCF is matched to a laboratory result, certain fields in the laboratory result 

will be locked from modification by the laboratory unless the match is rejected by 

the TA and/or Results Management Authority (RMA). The process to reject a 

match is as follows: 
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a) Search for the sample code in ADAMS and open the DCF page; 

b) Find and click the yellow button of laboratory result (i.e. Negative Result, AAF or 

ATF) at the bottom of the DCF;  

 

 

c) Click on No-Reject Match on the Result Verification page.  

 

 

 

5. Monitor DCF entry in ADAMS  
 
5.1 Criteria to match a DCF and a laboratory result in ADAMS 

 

In ADAMS, for a laboratory result (created by the laboratory) to be matched to its 

corresponding sample’s DCF (created by the ADO), the information in the 

following three fields must be identical: 

 

 Sample code 

 Sample type 

 Sport 

 

Only after the laboratory result and the DCF are matched will the TA be able to 

see the laboratory result on the DCF page in ADAMS, as well as in the “Analysis 

Results” column in the SCR.  
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5.2 Identify missing DCFs 

   

After eliminating the data entry mistakes by following the instructions in Section 

4 of this Guide, generate a new LRR in ADAMS to create an updated Excel 

spreadsheet (follow instructions of Section 2 of this Guide).  

 

In this updated LRR, check the column “Testing Authority from DCF”. No data in 

this column means that the laboratory result has not been matched to a DCF in 

ADAMS and therefore the DCF for this sample is considered “missing”.  

 

 
 

5.3 Identify laboratory results not matched to existing DCFs 

 

There is a possibility that the DCF has been entered in ADAMS but is not matched 

to the corresponding laboratory result due to conflicting information in the three 

matching criteria. Under such circumstance, the sample code is included in the 

SCR (based on DCF) but shows no value in the “Testing Authority from DCF” 

column in LRR because of the no-match. 

 

It is also possible that the DCF is entered in ADAMS and that the information in 

the three matching fields are also identical to the laboratory result, however 

there is still no value displayed in the “Testing Authority from DCF” column of the 

LRR. This may be due to data entry mistakes preventing the match between the 

laboratory result and the corresponding DCF.  

 

The following table shortlists have some common mistakes that can prevent the 

match between an existing DCF and laboratory result for the same sample code 

in ADAMS. It is important to carefully check the data for each sample code in 

question to identify the reason of no-match and take the corrective action 

accordingly. 

 
  



October 2017 V. 1.0 

Page 14 of 21 
 

 

 
Sample Code from 

ADAMS DCF  
(found on SCR) 

Sample Code 
from Lab 

Result 
(found on LR R) 

Reason for No-match Corrective Actions 

01234 1234 “0” is considered a number at the 
beginning of the sample code field. 

Remove the “0” at the beginning of the 
sample code field. 

123O 1230 Letter “O” typed by mistake instead of  

number “0” in the sample code field. 

Correct letter “O” to number “0” in the 

sample code field. 

“01234 ” “1234 ” A space is considered a number at the 

beginning or end of  the sample code 
field. 

Remove unnecessary spaces in the 

sample code field. 

1235 
12388 

1238 Any other mistakes in the sample code 
field can prevent the match. Mistakes 
are often due to misinterpretation of 
hand-writing on the original copy DCF 
or simply typos when the ADAMS DCF 
was created; as the lab has access to 
the sample bottle with official sample 
code, their sample code is usually 
correct.  

Review the original copy DCF to 
confirm the sample code number 
matches the lab’s and correct the 
sample code field accordingly.  

Boxing 
Bowls 
Para-Athletics 
Sitting Volleyball 
Table Tennis 
Etc. 

Kickboxing 
Bowling 
Athletics 
Volleyball 
Tennis 
Etc. 

Different sport codes. Review the original copy DCF to 
confirm the sport of the athlete tested:  
- If the sport field of the ADAMS DCF 

shows the wrong sport, simply 
amend it accordingly. 

- If the lab result shows the wrong 
sport, contact the lab to ask that 
they amend the result accordingly. 

Blood passport* Blood Different sample type. Review the original copy DCF to 
confirm the sample type: 
- If sample type field in the ADAMS 

DCF shows the wrong sample type, 

simply amend it accordingly. 
- If the lab result shows the wrong 

sample type, contact the lab to ask 
that they amend the result 
accordingly. 

Partial sample box is 
checked 

- ADAMS does not match a lab result to 
a partial sample. 

Uncheck the partial sample box in the 
ADAMS DCF and save. 

DCF status is 
“Cancelled” 

- ADAMS does not match a lab result to 
a cancelled DCF. 

- Use the "Correct" button** on top of 
DCF page to delete the DCF;   

- Enter a reason for deleting and save; 
- Create a new DCF with the same 

sample code. 

DCF status is 
“Created-In Process” 

- ADAMS does not match a lab result to 
a DCF that is not complete yet. 

- Use the "edit" button on top of DCF 
page to complete all mandatory 
fields in the DCF;   

- Change the DCF status to 
“Complete-Sample(s) collected and 
click on “Save”; 

 

*Blood and blood passport are two different sample types in ADAMS. If a whole blood 

sample is analyzed for both ABP and another prohibited substance(s), the sample code 

needs to be entered twice as “blood” and “blood passport” respectively on the DCF page in 

ADAMS. 

 

**If the “Correct” button does not appear on top of your screen, contact the ADAMS 

Administrator of your ADO to add this role to your ADAMS user account. 
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6. Standard process of calculating TDSSA level of analysis 

 
When all the DCFs have been entered into ADAMS and all the data entry mistakes have 

been eliminated by following the instructions in Section 5 of this Guide, generate a new SCR 

in ADAMS to create an updated Excel spreadsheet (follow instructions in Section 3 of this 

Guide) to monitor compliance with the TDSSA.  

 

Annex 1 to this Guide contains all sport-discipline combinations in the TDSSA Appendices 1 

and 2. It also includes the important parameters to be extracted from the SCR in order to 

calculate your TDSSA level of analyses. Sports and disciplines that are not covered by the 

TDSSA are not included in Annex 1 (e.g. triathlon/ironman). 

 

It is suggested to follow the alphabetic order of the sport-discipline combinations in Annex 1 

that are part of your testing program to determine the corresponding figures from the SCR. 

 

Here are the steps to extract the required information from the SCR. 

 

6.1 Click Data and Filter to apply the filter to the first row of headings in the SCR; 

 

 
 

6.2 Remove the samples that have no value or labelled as not analyzed in the 

Analysis Results column.  

 

6.3 Remove the samples collected from athletes who are not at the international and 

national levels by sorting the data in the Athlete Level column.  

 

6.4 Remove additional dilute urine samples that are collected from the same athlete 

in a single collection session. (The objective is to keep only one urine sample 

code per athlete per collection session in the report to count as one test.) You 

may need to refer to your own log of dilute samples to identify the additional 

dilute samples to be deleted. Alternatively, sort the data by athlete full name, 

date of test and sample type in the SCR.  

 

6.5 Select the first sport-discipline combination for which you want to determine the 

number of tests and level of analyses: 

 

a) Go to the Sport - Discipline column heading and click on the filter arrow; 

b) Unselect “Select all”; 

c) Select only the desired sport-discipline combination; Or type the sport in the 

Search box to find your choice and click OK. This helps to locate your choice 

when there is a long list of sport-discipline combinations. 

 

The report is now showing all samples that are analyzed for the selected sport-discipline 

combination (excluding additional dilute samples). 

 

https://www.wada-ama.org/en/resources/adams/reporting-guide-to-monitor-testing-annex-1


October 2017 V. 1.0 

Page 16 of 21 
 

OR        

 

6.6 Determine the total number of tests for the selected sport-discipline combination:  

  

a) Go to the Sample Type column heading and click on the filter arrow; 

b) Unselect “Select all”; 

c) Select Urine as the sample type; 

d) The number of selected items is shown at the left bottom corner of the 

spreadsheet. Record this number in column D of the Annex 1 - Total urine no 

dilute for the selected sport-discipline combination. 

 

 
 

e) If a blood only collection session* was conducted, the number of these blood 

samples should be recorded in column E of the Annex 1 – Samples in blood 

only collection sessions**. 

 

* A blood only collection session is considered a separate test and should be added to the 

urine samples in determining the total number of tests.  

 

** When an athlete provides both urine and blood samples during one sample collection 

session, this should be considered 1 test for statistical purposes. 
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Examples:   

Suppose an ADO collected 115 samples from a sport-discipline combination in a given 

period (i.e. 100 urine and 15 blood); among the 115 samples, 3 are additional dilute urine 

samples.  

 

Scenario 1:  

If all the blood samples were collected along with urine samples, the total number of tests 

would be 97, which is calculated as follows: 

 

Total samples  115 

Less additional dilute urine samples  3 

Less all blood samples         15 

Plus blood samples collected in Blood Only collection sessions      0 

Total tests:         97 

 

Alternatively, 100 urine samples minus 3 dilute urine samples for a total of 97 tests. 

 

Scenario 2:  

If 5 of the 15 blood samples were collected separately from the urine samples, the total 

number of tests would be 102, calculated as follows:  

 

Total samples  115 

Less additional dilute urine samples    3 

Less all blood samples  15 

Plus blood samples collected in Blood Only collection sessions     5 

Total tests:         102 

 

Alternatively, 100 urine samples minus 3 dilute urine samples plus 5 blood samples 

collected in Blood Only collection sessions for a total of 102 tests. 

 

6.7 Determine the number of ESAs analyses conducted for the selected sport-

discipline combination: 

 

a) Go to the Lab Analysis Type column heading and click on the filter arrow; 

b) Type ESAs as the keyword in the search bar and click OK to select all ESAs 

analyses; 

c) Record the number of selected items as shown at the left bottom corner of the 

spreadsheet in column I of the Annex 1 - ESAs analyses conducted. 
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6.8 Determine the number of GH analyses conducted for the selected sport-discipline 

combination: 

 

a) Go to the Sample Type column heading and click on the filter arrow; 

b) Unselect “Select all”; 

c) Select Blood as the Sample Type; 

d) Go to the Lab Analysis Type column heading and click on the filter arrow; 

e) Type GH as the keyword in the search bar and click OK to select all GH analyses; 

f) Record the number of selected items as shown at the left bottom corner of the 

spreadsheet in column M of the Annex 1 – GH analyses conducted. 

 

6.9 Determine the number of GHRFs analyses conducted for the selected sport-

discipline combination: 

 

a) Go to the Sample Type column heading and click on the filter arrow; 

b) Unselect “Select all”; 

c) Select Urine as the Sample Type; 

d) Go to the Lab Analysis Type column heading and click on the filter arrow; 

e) Type GHRF as the keyword in the search bar and click OK to select all GHRFs’ 

analyses; 

f) Record the number of selected items as shown at the left bottom corner of the 

spreadsheet in column Q of the Annex 1 – GHRFs’ analyses conducted. 

 

6.10 Repeat the steps 6.5 to 6.9 to calculate the number of tests and specific analyses 

for each of the sport-discipline combinations in your testing program. The 

following screenshot shows an example of the calculation results in Annex 1.  

 

 
 

 

7. An automated process of TDSSA monitoring 
 

ADOs that conduct tests in a large number of sport-discipline combinations and are familiar 

with Microsoft Excel functionality are recommended to use pivot tables and macros to 

perform the steps from 6.5 to 6.9 to monitor their compliance with the TDSSA.  

 

Annex 2 to this Guide is a Macro-Enabled Template (.xltm) with automated calculations for 

TDSSA monitoring. The steps to use the template are demonstrated in this video: 

 

https://www.wada-ama.org/sites/default/files/video_on_macro_template.mp4  

 

The steps are as follows: 

 

7.1 Generate and save a SCR in ADAMS and remove: 

 

a) samples that are not analyzed or still have lab results pending (section 6.2) 

https://wada-files.s3.amazonaws.com/reporting_guide_annex-2.xltm
https://www.wada-ama.org/sites/default/files/video_on_macro_template.mp4
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b) samples from athletes that are not at the international/national levels (section 

6.3) and; 

c) additional dilute samples that are collected from the same athletes in a single 

collection session (section 6.4). 

 

7.2 Open Annex 2, the macro template 

 

7.3 Copy the data in the SCR (edited as in section 7.1) and paste it to the first tab 

“SCR” of Annex 2; 

 

a) Make sure to copy the SCR data starting in cell A1; 

b) Make sure that the data finishes in column “X” - Lab Analysis Type (the SCR 

report template in ADAMS is already formatted as such) 

 

 
 

 

7.4 Run the macros to format the SCR data table and create the pivot tables: 

 

a) Go to the Developer tab in the menu.  

 

 
 

If you don’t see the Developer tab, go to:  

 

 File  

 Options 

 Customize Ribbon  

 Find “Developer” in the list on the left  

 Click “Add” to see the “Developer” in the Customize Ribbon 

 Click “OK” 
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b) Open “Macros” and run the TableSCR macro to format the SCR data. 
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c) Open “Macros” and run the PivotSCR_ESA_GHRF macro to create the pivot tables 

for ESAs and GHRFs. 

 

 
 

d) Open “Macros” and run the PivotSCR_GH macro to create the pivot table for GH 

following similar procedure as ESA and GHRF macro in the previous step. 

 

By now the TDSSA ALL table (5th Tab) will have been automatically filled with 

figures based on the Pivot tables. 

 

7.5 Save the file as macro-enabled workbook (.xlsm) file to keep access to all the 

macros. 

 

 
 

Important: Annex 2 is subject to regular updates to stay in line with the latest listing of 

sports and disciplines in ADAMS. ADOs should always download the latest version of 

Annex 2 from the WADA website to monitor their compliance with the TDSSA.  

 
8. Conclusion 
 

For further questions and inquiries regarding this Guide, please contact WADA’s 

Compliance Team at compliance@wada-ama.org. 

 

For further questions and inquiries regarding ADAMS account and reports, please contact 

the ADAMS Support Team at adams@wada-ama.org.  

mailto:compliance@wada-ama.org
mailto:adams@wada-ama.org

